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For safety, please read this manual carefully before you use this product and keep it
handy for future reference.




Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
e NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.
PostScript is a registered trademark of Adobe Systems, Incorporated.
Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows 95.

» The product name of Windows® 98 is Microsoft® Windows 98.

e The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

e The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

* The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

* The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

e Microsoft® Windows NT® Workstation 4.0



Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

% Quick Installation Guide
Describes how to install the printer.

< Setup Guide
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

« Printer Reference
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Operating Instructions”.

< Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions” (this manual).

< PostScript 3 Operating Instructions Supplement

Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

& Note
O There are three CD-ROMs that come with this printer. "Operating Instruc-

tions", "Printer Drivers and Ultilities", and "Document Management Utility".

O Concerning UNIX information, please visit our web site or consult your au-
thorized reseller.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

@ Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.
Keys on the computer's keyboard.



This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Windows 2000, Windows XP,
Windows NT (Server)

Windows 95/98/Me @" /\\
o )
Windows 2000 & - /\
Windows XP ii /\
Windows NT @ /\
R Ny —
NetWare
(Client) @
Macintosh N

UNIX

ﬂlmportant

O The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

/O Reference

For more information about configuring the Network Interface Board with
the control panel, see the Setup Guide.

< Features
¢ Support for 100BASE-TX, 10BASE-T, IP over 1394 and IEEE 802.11b.

e The Network Interface Board is compatible with NetWare ' (IPX/SPX,
TCP/1P), Windows NT 4.0 (TCP/IP, NetBEUI 2, IPP ?), Windows 2000
(TCP/IP, NetBEUI 2, IPP ?), Windows XP (TCP/IP, IPP ), Windows
95/98/Me (TCP/IP, NetBEUI 2, IPP ?), UNIX (TCP/IP) and Macintosh
(AppleTalk) protocols. This allows you to use the machine in a network
that uses different protocols and operating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

e The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.



"1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc

mode.

"2 To use NetBEUI, use the SmartNetMonitor for Client port.
3 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

« Interface supported protocols

Interface
Ethernet IEEE 802.11b IEEE 1394
(IP over 1394)
Protocol TCP/IP O] O O
NetBEUI O O X
NetWare O o X
AppleTalk o O X

O means that the protocol is supported.

x means that the protocol is not supported.

"1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc

mode.



Setting Up the Machine on a Network

Windows 95/98/Me, Windows 2000/Windows XP, Windows NT 4.0

For setting up the machine as a network printer in Windows 95/98/Me, Win-
dows 2000/ Windows XP and Windows NT 4.0 environment.

See p.1 “Windows 95/98/Me Configuration”.
See p.13 “Windows 2000 Configuration”.

See p.25 “Windows XP Configuration”.

See p.37 “Windows NT 4.0 Configuration”.

< Printing Without a Print Server

TCP/IP TCP/IP TCP/IP
NetBEUI NetBEUI PP
PP PP LPR
1 L Ny
Windows 95/98/Me ~ Windows 2000 Windows XP

TCP/IP
NetBEUI
PP

N

Windows NT 4.0

« Printing With a Windows 2000, Windows XP or Windows NT Print Server

Windows 2000, Windows XP or
Windows NT Server (or Workstation)
Print Server

Windows 95/98/Me Windows 2000 Windows XP

Windows NT 4.0



Vi

NetWare

For setting up the machine as a network printer in a NetWare environment, see
p-49 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
* See p.68 “Windows 95/98/Me” .

* See p.69 “Windows 2000” .

* See p.70 “Windows NT 4.0” .

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Print Server NetWare
File Server

5 ]
N~ 2 N\~
Windows 95/98/Me Windows 2000 Windows NT 4.0

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x
See p.55 “Setting Up as a Print Server”.

e NetWare 4.x,5/5.1
See p.61 “Setting Up as a Print Server”.



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

Remote Printer NetWare NetWare
Print Server File Server
I &
S S

Windows 95/98/Me Windows 2000 Windows NT 4.0

The actual procedures for configuring the machine depend on the NetWare ver-
sion.

¢ NetWare 3.x
See p.57 “Setting Up as a Remote Printer”.

e NetWare 4.x,5/5.1
See p.65 “Setting Up as a Remote Printer”.

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p-71 “Macintosh Configuration”.

AppleTalk

S

Macintosh

Vii



UNIX

Concerning UNIX printing information, please visit our Web site or consult your
authorized reseller.

TCP/IP

J

UNIX

Printing using the IEEE 802.11b Interface

This section describes how to print after installing the optional 802.11b Interface
Unit.

There are two methods of using this machine as a network printer with IEEE
802.11b.

% ad hoc mode
This is the mode for transmitting between each wireless LAN client. You
must make the channels the same for each wireless LAN client to transmit us-
ing this basic transmitting method which does not require an access point. See
p-87 “Using the IEEE 802.11b (Wireless LAN)”.

Viii



% infrastructure mode

This is the mode for transmitting via an access point. If an SSID "' and WEP
"2 are set in the access point, you must set the same values for the access point
and IEEE 802.11b. By connecting the access point to Ethernet, you can trans-

mit the current network environment. See p.87 “Using the IEEE 802.11b
(Wireless LAN)”.
*1

This is called a Service Set ID and is used in the connection between the wireless
LAN client and the access point. Only a wireless LAN client and an access point
that have the same SSID can transmit to each other. (The character strings to be set
are in the range ASCII 0x20-0x7e and the SSID is case-sensitive to 32 bytes.)

This is used to protect coded wireless data transmission. To transmit between
wireless LAN clients and the coded access point, you must set the same WEP key
as the printer. (You can set only 10 hexadecimal characters.)

*2

<+ad hoc mode ssinfrastructure mode

access point




Printing using the IEEE 1394 Interface

This section describes how to print via the IEEE 1394 interface after installing the
1394 Interface Unit Type 4510.

There are two methods of using the machine as a network printer with IEEE
1394.

< SCSI print
You can print using the SCSI print device provided by Windows 2000 and
Windows XP. For more information, see “IEEE 1394 Configuration” in the
Setup Guide.

< IP over 1394
You can print by setting the IP address for this machine and the computer on
which Windows XP is installed. For more information, see “IEEE 1394 Con-
figuration” in the Setup Guide and p.25 “Printing with a Standard TCP/IP
Port” in the Windows XP Configuration.

SCSl print
IP over 1394

&
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1. Windows 95/98/Me
Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98 /Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows NT Server, Windows NT Workstation, or NetWare based
print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e PP
¢ NetBEUI

ﬂ Configure the chosen protocol.
¢ See p.2 “Configuring TCP/IP and IPP for Printing”.
¢ See p.3 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Windows 2000 or Windows NT Print Server

See p.10 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000 or Windows NT print server.



Windows 95/98/Me Configuration

Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

A Reference
For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Enable the use of the command prompt as follows:

¢ On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [Command Prompt].

e On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring Protocols

Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

ﬂ Open [Control Panel] and then double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

& Note

O If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab
to install it. For more information about installing the TCP /IP protocol, see
Windows 95/98/Me Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.



Windows 95/98/Me Configuration

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI” is listed in the [The following network components are installed:]
box on the [Configuration] tab.

& Note
O If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

O If “NetBEUI —Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

ﬂ Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and then click [Properties].

B Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
then click [OK].

ﬂ Click [OK] to close the [Network] dialog box.

B When the message to restart appears, click [Yes].



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.7 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Details] tab, and then make sure that the SmartNetMonitor for
Client port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].
O click [Delete Port].

B Click the SmartNetMonitor for Client port name as in step ], and then click
[OK].

The port is deleted.
B Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

* The SmartNetMonitor for Client settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

g On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.



Using SmartNetMonitor for Client

ﬂ After the confirmation message, click [Yes].
B Acknowledge the [Question] dialog box.
E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click [SmartNetMonitor] from the list, and then click [OK].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.
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NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address], and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For more information about the printing of the configu-
ration page, see “Printing a Configuration Page” in the Setup Guide. The
NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration
page. Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these settings, see SmartNetMonitor for
Client Help.

A ciick [ox.
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-

lowing Port] box, and then click [OK].
This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.



Using SmartNetMonitor for Client

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

O You can configure Timeout Settings for the TCP/IP protocol.

ﬂ From the [Printers] window, click the printer icon. On the [File] menu, click
[Properties].

g Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
* For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Windows 2000, Windows XP or
Windows NT Print Server

NG

@
Windows 95/98/Me

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

ﬂ Install the printer driver as a local printer.

/O Reference

For more information about installing the printer driver, see the Setup
Guide.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

ﬂ Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].



Setting Up a Client Computer

ﬂ Click the [Details] tab, and then click [Add Port].
B Click [Network], and then click [Browse].

E On the network tree, double-click the name of the computer used as the
print server.

The printers connected to the network are displayed.
ﬂ Click the name of the printer you want to use, and then click [OK].
B click [0k,

ﬂ Make sure that the port name is displayed in the [Print to the following port]
box, and then click [OK].

11
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2. Windows 2000
Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e IPP
¢ NetBEUI

ﬂ Configure the chosen protocol.
¢ See p.15 “Configuring TCP/IP and IPP for Printing”.
e See p.16 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

@ Note

O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".

13
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Printing with a LPR Port

See p.22 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.23 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

& Note
O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [Programs], point to [Accessories], and then click [Com-
mand Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

B Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

g Click [Local Area Connection]. On the [General] tab, click [Properties].

15
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B Make sure that the”Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

B Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

g Click [Local Area Connection]. On the [General] tab, click [Properties].

BMake sure that the”NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O Select the NetBEUI protocol box if it is not already selected.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

¢ Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

17
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.19 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
@ select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step .

B Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.



Using SmartNetMonitor for Client

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and then click [Change/Remove].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].
The [Select Printer] dialog box appears and printers on the network are browsed.
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see "Printing a Configuration Page" in the Setup
Guide. The NetBEUI address appears as "\ \RNPxxxx\xxx" on the con-
figuration page. Type the printer's network path name in the form of
"%%Computer name \Share name". Do not type "\\" as head characters
but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.



Using SmartNetMonitor for Client

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k

ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].
This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears

¢ For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.

¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note

O For more information about these settings, see SmartNetMonitor for Client
Help.

2]
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

@ Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

B clicx [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled. For more information about how to install "Print Services for Un-
ix", see Windows 2000 Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

t click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].



Setting Up a Client Computer

Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Windows 2000, Windows XP or
Windows NT Print Server

@
Windows 2000

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.
B cick [Start], point to [Settings] and then click [Printers].

g Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and then click [Next >].
B Click [Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
23
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ﬂ Click the printer you want to use, and then click [Next >].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



e
3. Windows XP Configuration

Configuring Windows XP

Printing without a Print Server

The following procedure describes how to configure Windows XP to use the ma-
chine on a network without a Windows XP, Windows NT Server, Windows NT
Workstation or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e IPP

ﬂ Configure the protocol.
¢ See p.27 “Configuring TCP/IP and IPP for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows XP to enable Peer-to-Peer
printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows XP
Help.

& Note
O If a device model selection dialog box appears during the procedure to add
the standard TCP/IP port, select "RICOH Network Printer C Model".

25
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Printing with a LPR Port

See p.34 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000, Windows XP or Windows NT Print
Server

See p.35 “Setting Up a Client Computer” for configuring Windows XP with a
Windows 2000, Windows XP or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows XP to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.
To use the IP over 1394, see the Setup Guide.

& Note

O After setting the IP address, use the ping command to make sure that it has
been set correctly.

@ Click [Start], point to [All Programs], point to [Accessories], and then click
[Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows XP computer

Follow these steps to configure a Windows XP computer to use the TCP/IP pro-
tocol.

ﬂ Click [Start] on the taskbar, point to [Control Panel], and then click [Network
and Internet Connections].

ﬂ Click [Local Area Connection]. On the [General] tab, click [Properties].

& Note
3 With the IP over 1394, click [1394 Connection].

B Make sure that the“Internet Protocol (TCP/IP)” is selected in the [This con-
nection uses the following items:] box on the [General] tab.

& Note
O Select the TCP/IP protocol box if it is not already selected.

O If the TCP/IP protocol is not installed, click [Install...] on the [General] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows XP Help.

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.



Using SmartNetMonitor for Client

Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

¢ Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

* Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

* Installed options (e.g. Paper tray unit)

* Size and orientation of paper in each paper tray unit
* Total memory

¢ Installed fonts (including the downloaded fonts)

& Note

O Failure to meet any of the conditions above may result in unexpected
print results.

pe Reference
For more information about how to use SmartNetMonitor for Client,
see the "readmeXP.txt" file included on the CD-ROM labeled "Operat-
ing Instructions" (If the CD-ROM drive is D, the folder will be "D:\Net-
work\Netmon\Client\Disk1").
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.31 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.
B Select the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
@ select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step .

B Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.



Using SmartNetMonitor for Client

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ Click the [Add or Remove Programs]category, click [SmartNetMonitor for Client],
and then click [Change/Remove].

B After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Client.

ﬂ After the confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver for the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].
The [Select Printer] dialog box appears and printers on the network are browsed.
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.
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B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

@ Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [0k
ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.

To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.



Using SmartNetMonitor for Client

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

B Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
e For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-
ing and Timeout Settings.

* For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

@ Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocols, see p.27 “Configuring TCP/IP
and IPP for Printing”.

ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Add Port].
ﬂ In the [Available port types:] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled. For more information about how to install "Print Services for Un-
ix", see Windows XP Help.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

t click [Close].

8 Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Windows 2000, Windows XP or
Windows NT Print Server

(7]
N
Windows XP

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.
ﬂ Access the [Printers and Faxes] window from [Start] on the taskbar.

g Click [Add Printer] in the Printer Tasks category.
This launches the Add Printer Wizard.

B Click [Next >].

ﬂ Click [[A network printer, or a printer attached to another computer.], and then click
[Next >].

B click (Next >].

35



36

Windows XP Configuration

B In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
ﬂ Click the printer you want to use, and then click [Next >].

@ Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

O There is a Windows XP printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

B Select whether to use this printer as the default printer, and then click [Next >].

E) After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



4. Windows NT 4.0
Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

ﬂ Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.

e TCP/IP
e IPP
¢ NetBEUI

ﬂ Configure the chosen protocol.
* See p.38 “Configuring TCP/IP and IPP for Printing”.
¢ See p.39 “Configuring NetBEUI for Printing”.

B Install the software and set the printer driver port

e Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a LPR Port

See p.46 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See p.47 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
* Make sure that the TCP/IP protocol is set to active. (The default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide.

If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

@ Note

O After setting the IP address, use the ping command to make sure that it has
been correctly set.

@ Click [Start], point to [Programs], and then click [Command Prompt].

@ Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “TCP/IP Protocol” is listed in the [Network protocols] box on the [Proto-
cols] tab.

@ Note

O If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.
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ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

B Click the [Services] tab, and then make sure that “Microsoft TCP/IP Print-
ing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

5] Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
* Make sure that the NetBEUI protocol is set to active. (The default is active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and then change the
LAN adapter number (Lana Number).

ﬂ Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI Protocol” is listed in the [Network Protocols] box on the [Proto-
cols] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to
install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

ﬂ Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and then click [Properties].

B Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and then click [Edit].
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ﬂ Type “0” as the Lana Number.

& Note

O If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number a number other than “0”.

B click [0k,
E Click [Close], and then close the [Network] dialog box.
ﬂ After checking the message to restart, click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.
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Using SmartNetMonitor for Client

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

% SmartNetMonitor for Client features

* Sends a print job directly to the network printers without using a print
server.

* Notifies when a printing error occurs.

* Prints documents using other printers in the printer group when the spec-
ified printer is busy (Recovery Printing).

¢ Equally divides the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

ﬂlmportant
O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing or Parallel Printing.

* Printer models (for Parallel Printing only)

Installed options (e.g. Paper tray unit)

Size and orientation of paper in each paper tray unit

Total memory

Installed fonts (including the downloaded fonts)

& Note
O Failure to meet any of the conditions above may result in unexpected
print results.

? Limitation

O On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see SmartNetMonitor for Client Help.
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Installing SmartNetMonitor for Client

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.

After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.43 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

g Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.
B From the [Print to the following port] box, select [FILE].

A click [Apply].
The port which is currently in use is changed.

B ciick [pelete Port].

E After the confirmation message appears, click [Yes].
The port is deleted.

ﬂ Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client

5] Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the SmartNetMonitor for Client port as a printer port.

* You have performed login with the same user authority as that used to in-
stall SmartNetMonitor for Client.

ﬂ Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

ﬂ On the [Install/Uninstall] tab, click [SmartNetMonitor for Client] and click [Add/Re-
move].
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B After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

ﬂ After a confirmation message appears, click [Yes].
B Acknowledge the [Remove Shared File?] dialog box.

E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Ports] tab and click [Add Port].

ﬂ Click [SmartNetMonitor] from the list, and then click [New Port...].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.
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NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to a broadcast from the computer will be displayed.
To print to a printer not listed here, click [Specify Address] and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For information about the printing of the configuration
page, see "Printing a Configuration Page" in the Setup Guide. The Net-
BEUI address appears as "\ \RNPxxxx\xxx" on the configuration page.
Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer
ipp://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note

O For more information about these setting, see SmartNetMonitor for Cli-
ent Help.

A ciick [ox.

ﬂ Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].
This completes the settings.

To print, select the printer specified here. SmartNetMonitor for Client will
now direct print data to the printer automatically.
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server settings and IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Port Configuration].

The [Port Settings] dialog box appears

e For TCP/IP protocol, you can configure Recovery Printing, Parallel Print-
ing and Timeout Settings.

* For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see SmartNetMonitor for Client
Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

@ Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see p.38 “Configuring TCP/IP
and IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

& Note

O If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd] box.

B Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

t click [Close].

B Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.

When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Windows 2000, Windows XP or
Windows NT Print Server

(7]
N
Windows NT 4.0

? Limitation

O When using a print server connected to the printer with SmartNetMonitor for
Client, you cannot use Recovery Printing and Parallel Printing.

@ Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.
B cicx [Start], point to [Settings], and then click [Printers].

g Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Network printer server] and click [Next >].

ﬂ In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.
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B Click the printer you want to use and click [OK].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK] and follow the instruc-
tions on the screen.

O There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

E Select if you want to use this printer as the default printer, and then click
[Next >].

ﬂ After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



e
5. NetWare Configuration

This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

& Note

O NetWare must be set to active using the machine's control panel. For more in-
formation about how to set it, see the Setup Guide.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

? Limitation

O The NIB Setup Tool is supported to work with the following operating sys-
tems.
* Microsoft Windows 95/98/Me
* Microsoft Windows 2000
* Microsoft Windows NT 4.0

+ SmartNetMonitor for Admin
Using a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

& Note

O If you configure the NetWare printing environment by using SmartNet-
Monitor for Admin under the following environments, NetWare Client
provided by Novell is required.

e NDS mode in Windows 95/98
* NDS or Bindary mode in Windows 2000/ Windows NT 4.0

< Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the printer from the displayed list, refer to the config-
uration page printed from the printer. For more information about printing a
configuration page, see the Setup Guide.
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Installing SmartNetMonitor for Admin

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see the Setup Guide.

After installing SmartNetMonitor for Admin, see one of the following sections:

* To configure the Network Interface Board as a NetWare print server for the
first time, see p.51 “Quick Setup Using the NIB Setup Tool Wizard”.

* To use this computer with NetWare 3.x as a print server, see p.54 “NetWare
3.x - Advanced Settings”.

* To use this computer with NetWare 3.x as a remote printer, see p.54 “Net-
Ware 3.x - Advanced Settings”.

* To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.60
“NetWare 4.x,5/5.1 - Advanced Settings”.

* To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.60
“NetWare 4.x,5/5.1 - Advanced Settings”.

Running the NIB Setup Tool

I] Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment.

/O Reference

For more information about installing the NIB Setup Tool, see p.49 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see p.54 “NetWare 3.x - Advanced
Settings” or p.60 “NetWare 4.x, 5/5.1 - Advanced Settings”.

& Note

O This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

O If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

* Windows 95/98/Me in NDS mode configuration
¢ Windows NT 4.0 in NDS mode configuration
Windows NT 4.0 in Bindery mode configuration

¢ Windows 2000 in NDS mode configuration
* Windows 2000 in Bindery mode configuration

ﬂ Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

ﬂ Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B ciick (Wizard] and click [OK].
The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click to select the IPX address of the Network Interface Board you are con-
figuring, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
print a network configuration page to check the MAC address (Network
address).

51




52

NetWare Configuration

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].
ﬂ Type the print server name into the [Device Name] box, and then click [Next >].

The default setting is “RDP_" followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

8 In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

B Click [Next >].
A dialog box for configuring the NetWare environment appears.

[E Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

ﬂ] If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

[ﬂ If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and then type the context into the [Con-
text:] box.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

B click [Next >].

[ﬂ Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1"
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.
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[B If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box.

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

0 click [Next >].
A dialog box to acknowledge the printing environment appears.

() After checking the environment, click [Next >].

If you want to change the settings, click [< Back], and then make the settings
again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

iE After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a

NetWare print server for the first time, we recommend you use the Wizard
method. See p.51 “Quick Setup Using the NIB Setup Tool Wizard” .

Start the print server

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.
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Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].
The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.

@ Select [Bindery].

In the [File Server Name:] box, type the name of the file server in which a
) € YP
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE
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m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step {B.

@ From the [Available Options] menu, select [Print Queue Information], and then
press the [ENTER] key.

@ Press the [INSERT) key, and then type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows:

@ From the [Available Options] menu, select [Print Server Information] , and then
press the [ENTER] key.

@ To create a new print server, press the [INSERT]) key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

ﬂlmportant
O Use the same name as that specified in the NIB Setup Tool. (Step B).

© From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

O 1f you want to change the name of the printer, type a new name.

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

@ For type, select [Remote Other/Unknown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to the [Print Server Configuration] menu.

[ﬂ Assign print queues to the created printer as follows:
@ From the [Print Server Configuration] menu, select [Queues Serviced By Printer].
@ Select the printer created in step [B.
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.
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[BPress the [ESC] key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

@ Note

O To make sure that the printer is correctly configured, type the following
from the command prompt.

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
g Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B Ciick [Property Sheet] and click [OK].
The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B ciick [1PX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see a network configuration page to check the MAC address (Network Ad-
dress).

E Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name] box, type the name of the print server.
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@ In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

© In the [Print Server Operation Mode] group, click [As Remote Printer].
O In the [Remote Printer No.] box, type the printer number.

ﬂlmportant
O Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

m Create a print queue as follows:

& Note
O If you use a currently defined print queue, go to step (B.

@ From the [Available Options] menu, select [Print Queue Information], and then
press the [ENTER] key.

@ Press the [INSERT) key, and then type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] , and then
press the [ENTER] key.

@ To create a new print server, press the [INSERT]) key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

ﬁlmportant
O Use the same name as that specified in the NIB Setup Tool. (Step B).

©® From the [Print Server Information] menu, select [Print Server Configuration].
@ From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

ﬁlmportant
O Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step B-@).
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O Type a new name, if you change the name of the printer.

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

@ Select [Remote Parallel, LPT1] for type.

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and then click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menu].

[ﬂ Assign print queues to the created printer as follows:
@ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
@ Select the printer created in step [B.
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

[BPress the [ESC] key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

[@ Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.
% To exit

CAREE: unload pserver
% To start

CAREE: load pserver print server name

& Note
O If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

< To use NetWare 5/5.1

¢ If you use Pure IP, configure the machine to use the TCP/IP protocol. For
more information about how to make the settings, see the Setup Guide.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board ]

(Configure the NetWare )

v

5] Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.51 “Quick Setup Using the NIB Setup Tool Wizard”.

Start the print server

& Note

O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

O You should install the client software released from Novell in Windows be-
fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.
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Setting Up as a Print Server

ﬂlmportant

O You can set up the print server using the NDS or Bindery mode in NetWare
4.x,5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. See p.51 “Quick Setup Using the
NIB Setup Tool Wizard”.

& Note

O If you use Pure IP in NetWare 5/5.1, follow the procedure on p.63 “Using
Pure IP in the NetWare 5/5.1 environment”.

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B Click [Property Sheet] and click [OK].
B click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Sever Name:] box, type the name of the print sever.

@ In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

O Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
ﬂ] From Windows, run NWAdmin.

p Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and then click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue volume] box, click the [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After checking the settings, click [Create].

[B Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
on the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and then click [0OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
O Select the [Define additional properties] check box, and then click [Create].
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m Assign print queues to the created printer as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step @, and then
click [OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and then click [OK].
@ After checking the settings, click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (step @-@), and
on the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.
ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step @)
O Select the [Define additional properties] check box, and then click [Create].

[E Assign the printer to the created print server as follows.
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the printer created in step @, and then
click [OK].

© After checking the settings, click [OK].

& Note

O If the printer works as configured, the name of the print server appears
as an attached user.

Using Pure IP in the NetWare 5/5.1 environment

ﬂ Log on to the file server as an Admin or an Admin equivalent.
g Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B Click [Property Sheet] and click [OK].
The [Network board list] dialog box appears.

ﬂ Click [TCP/IP protocol].
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B Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note
O If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IP address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name:] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

© In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
O After the confirmation dialog box appears, click [OK].

[E On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
After this step, go to step ff] on p.61 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
See p.50 “Running the NIB Setup Tool” .

B Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

B Click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see the network configuration page to check the MAC address (Network
Address).

B Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

B Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

g Click the [NetWare] tab, and then make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

In the [File Server Name:] box, type the name of the file server in which a
) € YP
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

O In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the number of the printer.

ﬂlmportant
O Use the same number as that of the printer to be created in the print
server.

O Click [OK] to close the property sheet.
@ After the confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
m From Windows, run NWAdmin.

/O Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

m Create a print queue as follows:

@ Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and then click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue Volume] box, click [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

O After checking the settings, click [Create].

[B Create a printer as follows:

@ Select the container object the printer is located in, and then click [Create]
in the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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© In the [Printer name] box, type the name of the printer.
O Select the [Define additional properties] check box, and then click [Create].

[ﬂ Assign print queues to the created printer as follows:
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step @, and then
click [OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and then click [OK].
@ After checking the settings, click [OK].

[B Create a print server as follows:

@ Select the context specified using the NIB Setup Tool (Step @-@), and
on the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step @).

O Select the [Define additional properties] check box, and then click [Create].

m Assign the printer to the created print server as follows.
@ Click [Assignments], and then click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in the step @, and
then click [OK].

© In the [Printers] group, click the printer assigned in step @ , and then
click [Printer Number].

O Type the printer number and click [OK].

ﬂlmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step @-@).
@ After checking the settings, click [OK].

m Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.

< To exit
CAREE: unload pserver

% To start
CAREE: load pserver print server name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note
O Use the version of Novell Client provided with your operating system or the
latest version.

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

p Reference

For more information about installing the printer driver, see the Setup
Guide.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Add Port].

[ ciick [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
B Click the queue you want to print, and then click [OK].

B click [0k,
In the [Print to the following port] box, a network path to the printer appears.
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[m Click [OK] to close the Printer Properties, and again, open it.
B Click the [Printer Settings] tab.
m Select to clear the [Form feed] and [Enable banner] check boxes.

& Note
O You should not select these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.
B click (No).
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.

E From the [Port] list, select the queue you selected in step fJ, and then click
[Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click Noj.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities”into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

B The [Printer Installation] dialog box appears.

B From the [Port] list, select the queue you selected in step f], and then click
[Next >].

ﬂ Follow the instructions on the screen to complete the installation of the
printer driver.
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6. Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Basic Procedure

Change to EtherTalk J

(
( Configure the printer )
[ Change the printer name]

Change the zone

? Limitation

O The required version of Mac OS is 8.6 or later. (Mac OS X Classic environment
is supported.)

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

/O Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

ﬂ Open [Control Panel], and then double-click the [AppleTalk] icon.

g From the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

B Restart the Macintosh.
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Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

A Reference
For more information about configuration, see the Setup Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printerl” and “printer2”.

To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

/O Reference

For more information about using Printer Utilities for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.
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Using SmartNetMonitor for Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of net-
work printers, but also allows you to change the configurations of the Network
Interface Board using the TCP/IP protocol or IPX/SPX protocol.

SmartNetMonitor for Admin is equipped with the following functions.

¢ Limits the settings to be done from the control panel, and disables changes to
be made to some of the items.

¢ Enables the selection of paper type loaded in the printer.

¢ Switches to the Energy Saver mode, and wakes up from the Energy Saver

mode.

* Checks the information on printing, paper exhaustion, and such, on the com-

puter.

* Monitors multiple printers at the same time. When there are many printers,

you can create groups and classify the printers to facilitate management.

¢ Checks the printer's network settings and detailed information of devices.

¢ Enables you to change the printer's network settings.

* Checks the number of pages printed for each computer, using the user codes.

oS

Protocol Stack

Microsoft Windows 95/98 /Me

TCP/IP provided with Windows 95/98/Me
IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows
95/98

Novell Client for Windows 95/98

Microsoft Windows 2000

TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT /2000

Microsoft Windows XP

TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000

Microsoft Windows NT 4.0

TCP/IP provided with Windows NT
IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows
NT

Novell Client for Windows NT /2000

& Note

O Select the appropriate protocol stack for your operating system.
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Changing the Network Interface Board Configuration

ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX]. A list of printers appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer you want to change its configuration.

O From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

B Select [Wizard] or [Property Sheet], and then click [Next].
* When configuring the Network Interface Board for the first time, select
[Wizard].
* When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

@ Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

© A configuration list appears on the dialog box.
For more information about each item on the dialog box, see Help.



Using SmartNetMonitor for Admin

Managing the User Information

ﬂ Run SmartNetMonitor for Admin.

ﬂ Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].
A list of printer appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer whose statistics information you want to man-
age.

ﬂ From the [Tools] menu, select [User Management Tool].
The screen that prompts you to type a password appears.

B Type the password, and then click [OK].

& Note
O The factory default password is "password".

The User Code Maintenance Tool starts up.

For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.

Configuring the Energy Save Mode

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].
A list of printer appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B Click [Group], point to [Energy Save Mode], and select any energy saver mode
from the menu that appears.

For more information about settings, see SmartNetMonitor for Admin Help.
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Configuring the Network Interface Board
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

< Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

A Reference
For more information about configuring the machine to use the TCP/IP
protocol, see the Setup Guide.

< Operating system browser requirements

(O] Browser
Windows 95/98/Me
Windows NT 4.0
Windows 2000

Mac OS 8.6 ~9.1

Solaris 2.5/2.6/2.7/7/8

® Limitation

O Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

O The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

Microsoft Internet Explorer 4.01 or later

Netscape Navigator 4.06 or later

O This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web browser when you want to reload this machine infor-
mation.
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

@ Note

O If a DNS server is used on the network, you can type the host name as a URL.
For example, http:/ /webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and the host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-

tion about how to do this.

O When you use the proxy server, you must set up the proxy server address for
the Web browser you are using. Consult the network administrator for infor-
mation about how to set the proxy server.

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

i@klmportant

O When connecting via a dial-up
connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

@ Note

O The Help files are stored on the CD-
ROM labeled “Operating Instruc-
tions” in HTML format.

2. Menu Buttons

These Buttons are to configure the Net-
work Interface Board and for checking
the status of the machine.

& Note

O When you click [Configuration], a dia-
log box appears requesting the user
name and password. Type only the
password in this dialog box. The de-
fault password is “password”.

O The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.
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Configuring the Network Interface Board Settings

ﬂ Start the Web browser.

ﬂPoint your browser at the URL or IP address of the printer (e.g. ht-
tp /XXX XXX XXX XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

B Click [Configuration].
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password"
for the password.

B Click the item you want to configure, and then make all the settings.

The following items can be configured:

< [General]
Configure the general settings for the machine here.

< [TCP/IP]
Configure the TCP/IP-related settings for the Network Interface Board,
802.11b Interface Unit, and 1394 Interface Unit.

+ [SNMP]
Configure the appropriate community settings here. Up to 10 types of
community names can be registered.

< [NetWare]
Configure the settings for printing in a NetWare environment here.

< [AppleTalk]
Configure the Network Interface Board or 802.11b Interface Unit settings
related to the AppleTalk protocol.

+ [NetBEUI]
Configure the Network Interface Board or 802.11b Interface Unit settings
related to the NetBEUI protocol here.

% [IEEE 1394]
Configure the 1394 Interface Unit settings related to IP over 1394 and SCSI
print (SBP-2).

? Limitation
O This page is displayed when the 1394 Interface Unit is installed.



Configuring the Network Interface Board with a Web Browser

+ IPP Authentication
If using the IPP protocol, configure the authentication settings for printing
here.

< Paper Type

Select the paper type loaded in the machine from the drop-down menu.

< Password
Follow the procedure below to change the password.
Enter the password to change the network and machine settings or delete
spooled print jobs.

< IEEE 802.11b (Wireless LAN)
Configure the 802.11b Interface Unit settings related to communication.

? Limitation

O This page is displayed when the 802.11b Interface Unit is installed.

Verifying the Network Interface Board Settings

ﬂ Start the Web browser.

gPoint your browser at the URL or IP address of the printer (e.g. ht-
tp: /XXX XXX XXX XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

B Click [Config. Reference].
The dialog box for entering the password and user name is displayed.

ﬂ Click the item you want to check.
The following items can be checked:

« [General]
Shows general settings for the machine.

“ [TCP/IP]
Shows the TCP/IP-related settings for the Network Interface Board,
802.11b Interface Unit, and 1394 Interface Unit.

< [NetWare]
Shows the settings for printing in a NetWare environment.

< [AppleTalk]
Shows the Network Interface Board or 802.11b Interface Unit settings re-
lated to the AppleTalk protocol.
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< [NetBEUI]
Shows the Network Interface Board or 802.11b Interface Unit settings re-
lated to the NetBEUI protocol.

« [IEEE 1394]
Shows the 1394 Interface Unit settings related to IP over 1394 and SCSI
print (SBP-2).

+ [IEEE 802.11b (Wireless LAN)]
Shows the 802.11b Interface Unit settings related to communication.

iQ'f‘Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

@ Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names; for example,
English Help files are in the [EN] folder. Make sure to copy the entire [EN] fold-
er to the new location.

® Using a Web Browser, navigate to the Top Page and click [Network config].
® Type your password, (it is not necessary to type a user name) and click [OK].

@ Type the path to the Help files in the [Help URL] box.
If you copied the Help files to “C:\HELP\EN", type “file:/ /C:/HELP/”. For
example if you copied the files to a Web server and the index URL is “ht-
tp://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

® Click [Apply].
When a warning message appears, select to continue configuration.



Monitoring and Configuring the Printer

Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to easily iden-
tify the printers listed on SmartNetMonitor for Client.

The following utilities are used to change printer names and comments.

< SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartNetMonitor for Admin
from the CD-ROM that comes with the printer. For more information about
installing SmartNetMonitor for Admin, see the Setup Guide.

< Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

& Note

O Each of the names, in a TCP/IP protocol form (printer name) and in a Net-
BEUI protocol form, is changed individually. Comments are, however,
common to both of them.

O The factory default name consists of "RNP" and the last 3 bytes of the MAC
address on the Network Interface Board. For example, when the MAC ad-
dress is 00:00:74:62:7D:D5, the factory default name is "RNP627DD5".
Comments are not configured.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].
A list of printers appears.

& Note
O Select the protocol of the printer you want to change its configuration.

B On the list, Select a printer whose Network Interface Board you want to
change its configuration.

ﬂ From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.
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B select [Property Sheet], and then click [OK].

TCP/IP

@ Click the [General] tab, and then type the device name into the [Device
Name] box and comment into the [Comment] box.

In the [Device Name] box, type the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

In the [Comment] box, type any comment on printers in under 31 charac-
ters.

NetBEUI

@ Click the [General] tab, and then type the comment into the [Comment]
box.

In the [Comment] box, type any comment on printers in under 31 characters.
@ Click the [NetBEUI] tab.
© Type the computer name into the [Computer Name] box.

In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/5<=>?[\]l. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

In the [Comment] box, type any comment on printers in under 31 charac-
ters.

A ciick [ox.
The NIB Setup Tool exits, and the setting is transmitted to the printer.

ﬂ Exit SmartNetMonitor for Admin.



Monitoring and Configuring the Printer

Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer you want to change the
settings)"".
The status of the selected printer is displayed on the Web browser.

B Click [Configuration].

A dialog box that prompts you to type the user name and a password ap-
pears.

ﬂ Type the user name and the password, and then click [OK].

Type only the password in this dialog box. The factory default password is
"password".

B Change names and comments.

TCP/IP

@ Click [General], and then type the name into the [Device Name:] box and
comment into the [Comment] box.

* In the [Device Name:] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to in under 13 characters.

* In the [Comment] box, type any comment on printers in under 31 charac-
ters.

@ Click the [IEEE 1394], and then type the name into the [Device Name:] box
when you change the device name for IEEE 1394 (IP over 1394) interface.

¢ In the [Device Name:] box, enter the name of the printer in under13 char-
acters. The factory default name consists of "RNP" and the last 5 bytes
of the EUI-64 on the IEEE 1394 (IP over 1394) Interface. For example,
when the EUI-64 is 00:00:74:00:02:01:0A:66, the factory default name is
"RNP0002010A66". No name of 13 characters is permitted if the prefix is
"RNP".

83



84

Appendix

NetBEUI

@ Click [NetBEUI].

@ Type the name into the [Computer Name] box and comment into the [Com-
ment] box.

* In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/5<=>?[\]l. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

* In the [Comment] box, type any comment on printers in under 31 charac-
ters.

A click [Appiy].
The setting is transmitted to the printer.

ﬂ Exit the Web browser.

Displaying the Status of Printer

You can view the status of printers using SmartNetMonitor for Admin, Smart-
NetMonitor for Client, or Web browser.

SmartNetMonitor for Admin

ﬂ Run SmartNetMonitor for Admin.

g Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].
The status of printers is indicated with an icon in the list.

& Note

O For more information about the status icons, see SmartNetMonitor for Ad-
min Help.

B Getting further information, click the desired printer to select from the list,
and then click [Open] on the [Device] menu.

The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.
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SmartNetMonitor for Client

Viewing the status of printers using SmartNetMonitor for Client, you must, in
advance, configure SmartNetMonitor for Client so it monitors the printer whose
status you want to view.

Monitoring Printers

ﬂ Run SmartNetMonitor for Client.
The SmartNetMonitor for Client icon appears at the right end of the taskbar.

g Right-click the SmartNetMonitor for Client icon, and check if the desired
printer is configured on the pop-up menu that appears.

If it is configured, see SmartNetMonitor for Client Help.

B If the desired printer is not configured, click [Options] on the pop-up menu.
The [SmartNetMonitor for Client - Options] dialog box appears.

ﬂ Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

& Note

O Selecting the [Displayed on Task Bar] check box will bring up the status of a
printer with an icon on the SmartNetMonitor for Client icon on the task
tray.

B ciick [ox.

The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

ﬂ Run SmartNetMonitor for Client.

g The status of printers is displayed on the SmartNetMonitor for Client icon
on the task tray.

& Note
O For more information about the status icons, see SmartNetMonitor for Cli-
ent Help.

B Getting further information on the status, right-click the SmartNetMonitor
for Client icon, and then click the desired printer.

The status of the printer is displayed on the dialog box.

& Note
O For more information about each item on the dialog box, see Help.
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Web Browser

ﬂ Run the Web browser.

g Type the address "http:// (IP address of the printer whose status you want
to view)".

The status of the selected printer is displayed on the Web browser.
B Click [Status] and you can check the status of the printer.

& Note
O For more information about each item, see Help.



Using the IEEE 802.11b (Wireless LAN)

Using the IEEE 802.11b (Wireless LAN)

5] Preparation
Use the WiFi authorized card for an access point and the IEEE 802.11b card in
the computer.

Setting IEEE 802.11b (Wireless LAN)

Connect the printer and the computer in Ad hoc Mode. Then set up IEEE 802.11b
(Wireless LAN) according to your network environment using the following
procedure.

? Limitation

O To connect in Infrastructure Mode, after connecting the printer and the com-
puter in Ad hoc Mode, make settings using a Web browser and telnet by fol-
lowing procedures B to B in "Using in Infrastructure Mode".

Using in Ad hoc Mode See p.88 “Using in Ad hoc Mode”.

Using in Infrastructure Mode 0 See p.88 “Using in Ad hoc Mode”.

B See p.89 “Using in Infrastructure Mode”.
B See p.90 “Setting SSID”.

O See p.90 “Applying the Settings”.

B See p.91 “Confirming the Connection”.

Using WEP When using WEP, the following procedures
are required after B, “Setting SSID”.

B-@ See p.90 “Setting the WEP Key”.
B-@ See p.90 “Using WEP”.
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Using in Ad hoc Mode

ﬂ Press [Menu).
"Menu" appears on the panel dis-
play.

ﬂ Press [A] or [ V] to display "Host
Interface", and then click [OK]).

B Press [A] or [ V] to display "Net-
work Setup, and then click [OK].

The following is displayed when
installing the 802.11b Interface
Unit in the printer with Ethernet as
standard equipment.

If the 802.11b Interface Unit has
been installed in the printer with
Ethernet as standard equipment,

go to step 3.

ﬂ Press [A]) or [ V] to display "LAN
Type", and then click [OK].

B Press [A] or [ V] to display "IEEE
802.11b ", and then click [OK].

88

EMake the network settings. The

following items must be set:
e P Address

¢ Subnet Mask

* Gateway Address

¢ Network Boot

¢ Frame Type (NW)

¢ Active Protocol

For more information about how
to make the settings, see the Setup
Guide.

ﬂ Make setting for the computer.

Set the transmission mode of the
IEEE 802.11b card installed in the
computer to ad hoc mode and the
channel to 11. Make the computer
network settings. The following
items must be set:

e [P Address
e Subnet Mask

A Reference

For more information about
how to make setting for the
IEEE 802.11b card installed in
the computer and the computer
in use, see the appropriate oper-
ating instructions or consult
your network administrator.

& Note

O Depending on the client soft-
ware of the IEEE 802.11b card
installed in the computer, the
channels might not be able to be
set. In this case, set the printer
channel to the channel specified
by the computer.
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O Depending on the client soft-
ware of the IEEE 802.11b card
installed in the computer, set-
ting IBSS (Independent Base
Service Set or Network Name)
may be required. If you have to
make settings, set the value as
"ASSID".

O Inan IEEE 802.11b environment
using the access point set as
"ASSID" in SSID, you may not
be able to connect the computer
and the printer in ad hoc mode.

B Press [On Line].

g Make sure the computer and the
printer are connected.

p Reference

See p.91 “Confirming the Con-
nection”.

Using in Infrastructure Mode

Make setting for infrastructure mode
from the control panel of the printer,
telnet, or a Web browser.

For more information about how to
make settings from the control panel
of the printer, see the Setup Guide.

For more information about how to
use telnet and a Web browser, see
p.76 “Configuring the Network Inter-
face Board with a Web Browser” or
p-92 “Remote Maintenance by tel-
net”.

The following procedure uses a Web
browser.

5] Preparation

When using the printer in infra-
structure mode, you need the ac-
cess point in use or information
(SSID and WEP key) about the ac-
cess point that will be used. Make
SSID and WEP key settings at the
same time.

For access point information, see
the appropriate operating instruc-
tions, or consult your network ad-
ministrator.

Changing to Infrastructure Mode

n Start the Web browser of a wire-
less LAN client connected in ad
hoc mode.

ﬂ Point your browser at the URL or
IP address of the printer (e.g. ht-
tp/IXXX XXX XXX XXX where the
Xs are the number of the IP ad-
dress).

The status of the printer you chose
appears on the Web browser.

B Click [Configuration].

The dialog box for entering the
password and user name is dis-

played.

ﬂ Enter your user name and pass-
word, and then click [OK].

B ciick [IEEE 802.11b].
BChange [Communication Mode] to

[Infrastructure mode].

If using SSID, seep.90 “Setting
SSID”.

If not using SSID, seep.90 “Apply-
ing the Settings”.
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Setting SSID Using WEP

B crick piEEE 802.11b). fFimportant

g . O To enable the WEP key, be sure to
Enter a value in [SSID]. first enter a value for the WEP key.
#¥important Seep.90 “Setting the WEP Key”.

O If you cannot connect after mak-
ing SSID and WEP key settings,
select "WL.LAN Defaults" from
the control panel, and then set
IEEE 802.11b (wireless LAN)
from the beginning. For more
information about how to use
the control panel, see the Setup
Guide.

& Note

O The character strings to be set
are in the range ASCII 0x20-
0x7e and the SSID is case-sensi-
tive to 32 bytes.

If using the WEP key, see p.90 “Set-
ting the WEP Key”.

If not using the WEP key, seep.90
“Applying the Settings”.

Setting the WEP Key

ﬂ Click [IEEE 802.11b].
ﬂ Enter a value in [WEPKey].

@ Note

O Youcanset only 10 hexadecimal
character strings.

B Change to enable use of WEP.
See p.90 “Using WEP”.

O With some products, depending
on the access point or IEEE 802.11b
card in use, it is possible to set
more than one WEP key. In this
case, make the first key the same as
the WEP key set in the printer.

B ciick iEEE 802.116].
B Change [Encryption] to [Enable].

B Apply all the settings.
See p.90 “Applying the Settings”.

iﬁklmportant

O If you cannot connect after mak-
ing SSID and WEP key settings,
select "WL.LAN Defaults", and
then make setting for IEEE
802.11b (wireless LAN) from
the beginning. For more infor-
mation about how to use the

control panel, see the Setup
Guide.

Applying the Settings

B click [Refresh] or [Reload].
The settings are transmitted.

& Note

O To verify the settings, click [Con-
fig Reference], and then click
[IEEE 802.11b].

ﬂ Exit the Web browser.



Using the IEEE 802.11b (Wireless LAN)

Confirming the Connection

nMake sure the LED of the IEEE
802.11b card is lit.

—_

e Tam
-

|Lf
N

ZGDH600J

1. If the IEEE 802.11b card is on, it
lights in orange. If the IEEE 802.11b
(wireless LAN) is not selected, it
does not light, even if the printer
power is on.

2. If it is connected properly to a net-
work, the LED lights in green with
infrastructure mode, it is not con-
nected to a network. Check the net-
work environment.

ﬂ Use a Web browser to check that
the printer is connected properly.
See p.76 “Configuring the Net-
work Interface Board with a Web
Browser”.

BPrint the configuration page to
verify the settings.

For information about how to print
the configuration page, see the Set-
up Guide.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

@ Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote maintenance.

Using telnet

The following is a sample procedure using telnet.

? Limitation

O Only one person at a time can be logged on to do remote maintenance.

ﬂ Using the IP address or host name of the machine, start telnet.

% telnet IP address

@ Note

O In order to use the host name instead of the IP address, you must write it
to the hosts file.

g Type the password.

& Note
O The default is “password”.

B Type a command.

A Reference
For more information about telnet commands, see p.93 “Commands List”.

ﬂ Exit telnet.
msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.

B Type “yes” to save the changes, and then press the [ENTER] key.

If you do not want to save the changes, type “no”, and then press the [ENTER]
key. If you want to make additional changes, type “return” at the command
line, and then press the [ENTER] key.

& Note

O If the “Cannot write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.

O The Network Interface Board is reset automatically when the settings are
changed.
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O When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

Use this command to display remote maintenance use.

& Note
O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that
command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP/IP (IP address, subnet mask, broad-
cast address, default gateway address) for the machine.

«» Reference
msh> ifconfig

< Configuration
msh> ifconfig interface name parameter address

Interface name Interface to be configured
ether Ethernet Interface ™

naf0

ip1394 2 IEEE 1394 Interface

fwip0 2

wlan " IEEE 802.11b Interface
wi0 3

"I If you did not enter the interface name, it will be automatically set to the Ethernet
interface.
"2 Available when the 1394 Interface Unit Type 4510 is installed.

3 You can specify an interface when installing the optional 802.11b Interface Unit

Type A.
Parameter Meaning
(no parameter) IP address
netmask subnet mask
broadcast broadcast address
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< Changing the Interface
You can specify either the LAN interface or IEEE 802.11b interface when us-
ing the optional 802.11b Interface Unit.

msh> ifconfig interface up

& Note
O You cannot specify the optional IEEE 1394 Interface Unit.

The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

& Note
O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O The TCP/IP setting is the same as that for the LAN interface and IEEE 802.11b
interface.

O To type an address using hexadecimal, prefix it by “0x”.

’iQ'FAddress

% Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

& Note
O To get the above addresses, contact your network administrator.

O The subnet mask is the same as that for the LAN interface and IEEE 802.11b
interface.

O When installing the optional 1394 Interface Unit, set the subnet so that it does
not overlap with the LAN interface or the 1394 interface.
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Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

+% Reference

msh> access

< Configuration
msh> access W range start-address end-address
* 3 represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)
Example: To specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

& Note

O The access range restricts the workstations from which printing is possible
by means of an address. If you do not need to restrict printing, make the
setting “0.0.0.0”.

O The entry is invalid if the start address is greater than the end address.

O Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

O When using a Web browser, telnet or SmartNetMonitor for Client/ Admin,
you can use an IP address that has not been restricted by access control.

< Access Control Initialization
msh> access flush

& Note

O This restores the factory-default settings so that all access ranges become
"0.0.0.0".

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

“on” means active and “off” means inactive.

Parameter Meaning
dhcp DHCP (Dynamic Host Configuration
Protocol)
& Note

O When you use DHCP, the server also needs to be configured.
O DHCP takes precedence over all other settings.
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Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Protocol

appletalk “up” means active and “down” means
tepip inactive.

netware

netbeui

scsiprint !
ip1394 1
lpr
ftp
rsh
diprint
web
snmp
ipp

"1 Available when the 1394 Interface Unit Type 4510 is installed.

@ Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using
ip1394, lpr, ftp, rsh, diprint, web, snmp and ipp.

Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray,
printer language of printer.
prnlog [ID] Lists the last 16 print jobs.
& Note

O More information about any print job is displayed when the ID number is
added after the prnlog command.
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p Reference

For more information about the meaning of the data returned with these com-
mands, see p.110 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-p]

& Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

p Reference

For more information about the meaning of the data returned with this com-
mand, see p.110 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system
log.
msh> syslog

/O Reference

For more information about the displayed information, see p.113 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

& Note
O The 1394 Interface Unit Type 4510 supports TCP/IP only.
O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only read-write
trap off trap off
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2
%

2
%

L)

Display

Shows the SNMP information and available protocols.
msh> snmp ?

msh> snmp [-pl [registered numberl]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.

Community name configuration
You can set the community name of the registered number.

msh> snmp number name community name

& Note
O The community name must consist of 15 characters or less.

Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

Protocol configuration
You should use the following command to set the protocols to active or inac-

tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled.

msh> snmp {ip | ipx} {on | off}
* “on” means active and “off” means inactive
To change the protocol of an access settings, use the following command.

However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

Access configuration

You can configure the address of a host depending on the protocols used.
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:

msh> snmp number {ip | ipx} address
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& Note
O To specify the TCP/IP protocol, type ip followed by a space, and then the
IP address.

O To specify the IPX/SPX protocol, type ipx followed by a space, and then
the IPX address followed by a decimal, and then the MAC address of the
Network Interface Board.

The following is an example of how to configure registration number 3 with

the IP address 192.168.15.16.

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with

the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.

msh> snmp 3 ipx 7390A448:000074625C65

IPP

Use the ipp command to configure the IPP settings.
< Viewing setting
The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900 (sec)

auth basic
¢ The “timeout” setting specifies how many seconds the computer keeps try-

ing to access the network printer to send print jobs when no connection can

be made.

* The “auth” setting indicates the user authorization mode.

< IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been

interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh> ipp timeout {30 - 65535}

< IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .

ipp auth {basic|digest|off}
e “basic” and “digest” are user authorization setting.
e “off” removes the user's authorization.

@ Note

O If you select “basic” or “digest”, see next section “Entry the IPP User Au-
thorization” for how to configure the user name. Up to ten user names are
available.
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« Configuring the IPP user authorization

Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:userl
IPP password:****k*%*
After configuring the settings, the following message appears.

User configuration changed.

Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.

Use the diprint command to change the direct printing port settings.

9
%

9
%

View settings
The following command displays the current direct printing port settings.

msh> diprint
Example output:

port 9100
timeout=300 (sec)
bidirect off

e The “Port” specifies the port number of the direct printing port.

¢ The “bidirect” setting indicates whether the direct printing port is bidirec-
tional.

Setting timeout

You can specify the timeout interval to use when receiving data from the net-
work.

msh> diprint [0~65535]

& Note
O The factory default is 300 seconds.

O If 0 is set, timeout is disabled.

Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.

msh> diprint bidirect {on|off}

& Note

O If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on
Windows 2000 might not work correctly.
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SMB
Use the smb command to configure or delete the computer name or workgroup
name for NetBEUL
msh> smb parameter
Parameter Settings
comp Your computer name consisting of up to 13 characters
group Workgroup name consisting of up to 15 characters
comment Comment consisting of up to 31 characters
clear comp Clears the computer name
clear group Clears the Workgroup name
clear comment Clears comment

ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

@ Note

O The maximum number of routing tables are 16.

Commands

Topics of setting

route add {host | net} desti-
nation ! gateway !

Adds a host/network route to “destination”, and a gateway ad-
dress to “gateway” in the table. Host becomes the default setting.

route delete {host | net}
destination !

Deletes a host/network route from the table. Host becomes the
default setting.

route get {destination " }

Displays only route information corresponding to a specified
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination ' on/off

You can turn the specified destination on or off. Host becomes
the default setting.

route add default gateway
1

You can set the default gateway address.

route flush

Deletes all routing information.

L IP address
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SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PurelP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

@ Note

O The default value of TTL is “1”. A search is executed only within a local seg-
ment. If the router does not support multi-cast, the settings are not available

even if the TTL value is increased.
O The acceptable TTL value is 1 - 255.

msh> slp ttl {1 - 255}

Setting IEEE 802.11b

To make setting for IEEE 802.11b, use the wiconfig command.

? Limitation

O You can make settings when installing the optional 802.11b Interface Unit.

< View settings

The IEEE 802.11b settings are displayed.

msh> wiconfig

The IEEE 802.11b card information is displayed.

msh> wiconfig cardinfo

@ Note

O If the IEEE 802.11b interface is not working correctly, the IEEE 802.11b card

information is not displayed.

< Configuration

Parameter

Value to be configured

mode [ap | adhoc]

You can set infrastructure mode (ap) or ad
hoc mode (adhoc).

The default is ad hoc mode.

ssid ID value

You can set for SSID in infrastructure mode.

The characters that can be used are ASCII
0x20-0x7e (32 bytes).

A SSID value is set automatically to the near-
est access point if the setting has not been
made.

If the setting has not been made for ad hoc
mode, the same value as for infrastructure
mode or an "ASSID" value is set automatical-
ly if the setting has not been made.
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Parameter Value to be configured

channel frequency channel no. You can set the channel.

You can specify from following channel.
¢ Metric Version :1-13

e Inch Version :1-11

Set the same channel for all the machines you
are using.

enc [on | off] You can enable or disable the WEP function.
To enable the WEP function, specify [on]; to
disable it, specify [off].

To start the WEP function, enter the correct
WEP key.

key [key value] Only 10 hexadecimal characters can be used.

To use this function, set the same WEP key
for all the ports that transmit to each other.

auth [open | shared] You can set the authorized mode when using
WEP. The specified value and the authorized
mode are as follows:

open: Open system authorized (default)
shared: Shared key authorized

rate [auto | 11m | 5.5m | 2m | 1m] You can set the IEEE 802.11b transmitting
speed.

The transmitting speed you specify here is
the speed at which data is sent. You can re-
ceive data at any speed.

auto: automatically set (default)
11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Job Spool

Use this command to configure Job Spool settings.

? Limitation

O You can only specify the LPR and IPP protocol.

& Note

O This machine information cannot reload automatically when you confirm the
Job spool settings on the Web browser. Click [Reload] or [Refresh] on the Web
browser when you want to reload this machine information.

“ Reference
The job spool setting appears.

msh> spoolsw
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< Job Spool Setting

msh> spoolsw spool {on | off}

& Note
O Specify "on" to enable the job spool function or "off" to disable it.

< Clearing Spool Job
If the printer is turned off accidentally during a spool job, you can specify
whether the job will be reprinted when the printer is turned back on.

msh> spoolsw clearjob {on |off}

< Protocol Configuration
To change the protocol settings, use the following command. You can specify
the setting for [Ipr] or [ipp].

o Ipr
msh> spoolsw lpr {on |off}

* 1pp
msh> spoolsw ipp {on |off}

Changing the Host Name

Use the hostname command to change the printer name.

msh> hostname [interface name ] printer name

interface name Interface to be configured
ether Ethernet interface ™

wlan 2 IEEE 802.11b interface
ip1394 "3 IEEE 1394 interface

"I If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.

"2 If you install the 802.11b Interface Unit Type A, you can set the command.

3 If you install the 1394 Interface Unit Type 4510, you can set the command.

& Note

O Enter the printer name using up to 13 characters.
O You cannot use a printer name starting with RNP or rnp.

O The Ethernet interface and IEEE 802.11b interface will have the same printer
name.
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WINS

Use the wins command to configure the WINS server settings

For more information about WINS server settings, see p.122 “Configuring a
WINS Server”.

< Viewing setting
The following command displays the WINS server IP address.
msh> wins
Example out put:
wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:
primary server 192.168.10.1 secondary server
192.168.10.2
hostname RNP620B47 ScopelD

& Note

O If DHCP is used to start from the network, the current WINS server ad-
dress is displayed. This address, however, is not displayed if DHCP is not
used.

O If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

< Configuration
Use the set command to make WINS active or inactive.

msh> set wins {on|off}

¢ "on means active and "off" means inactive.

< Address configuration
Use this command to configure a WINS server IP address.

msh> wins {primary|secondary} IP address

& Note
O Use the "primary" to configure a primary WINS server IP address.

O Use the "secondary " to configure a secondary WINS server IP address.

AutoNet

Use the set command to configure AutoNet.

& Note

O For more information about AutoNet, see p.121 “Using AutoNet”.
msh> set autonet {on|off}

"on" means active and "off" means inactive.
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SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

? Limitation

O SNTP supports the NTP servers running xnptd V3 and V4.

% Reference
msh> sntp

< NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP address

« Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling time

& Note
O The factory default setting is 3600 seconds.

O You can set the interval from 16 to 16384 seconds.

O If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

« Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.

msh> sntp timezone +/—hour_time
Example: To set the time-zone difference to +8 hours:

msh> sntp timezone +08:00

& Note
O The time is in 24-hour notation.
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Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.
01ld password:

B Type the new password.

New password:

& Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:

107



108

Appendix

SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

/O Reference

You can configure SNMP from the command line using telnet. See p.97
“SNMP”.

You can configure SNMP from SmartNetMonitor for Admin using the NIB
Setup Tool. See Help for SmartNetMonitor for Admin.

You can configure SNMP from your Web browser. See Help on the CD-ROM.

? Limitation

O The kinds of supported MIBs vary depending on the printer.

< Supported MIBs
e MIB-II
¢ PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
¢ telnet: Use the status command. See p.96 “Printer status” .

Item name Meaning
Rank Print job status.
¢ Active
Printing or preparing for printing.
¢ Waiting
Waiting to be transferred to the printer.
Owner Print request user name.
Job Print request number.
Files The name of the document.
Total Size The size of the data (spooled).

The default is “0 bytes”.

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
¢ telnet: Use the prnlog command. See p.96 “Printer status” .

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received
UserID ™ User ID that is to be configured in the printer driver.
JobName The name of the document for printing.

"I Appears the UserID and JobName information when entering the info command
with the ID.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.

e telnet : Use the show command. See p.97 “Network Interface Board configu-
ration settings information” .

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk

TCP/1P

NetWare

NetBEUI

IP over 1394 ™

SCSI print
Ethernet interface
Syslog priority Internal version number.
NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk
Mode AppleTalk protocol in selection.

Net Network number.

Object Macintosh printer name.

Type The type of printer.

Zone Name of the zone that the printer belongs to.
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Item name Meaning
TCP/IP
Mode Up means active, Down means inactive.
ftp
lpr
rsh
diprint
web
telnet
snmp
ipp
EncapType Frame type.
Network boot Network boot.
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
Gateway Default gateway address.
Access Range[+] ™ Access Control Range.
Primary WINS Primary WINS server address.
Secondary WINS Secondary WINS server address.

Time server
Time Zone

Time server polling time

NTP server address
NTP server time difference

Synchronizes interval

Home page URL URL of homepage.

Home page link name URL name of homepage.

Help page URL URL of help page.

SNMP protocol Protocol used with SNMP.
NetWare

EncapType Frame type.

RPRINTER number Remote printer number.

Print server name
File server name
Context name
Switch
Mode
NDS/Bindery
Packet negotiation

Print job timeout

Print server name.
Name of the connect file server.

Context of print server.

Active mode.

(this value is fixed)

Time of the job timeout.
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Item name Meaning
NetBEUI
Switch
Mode (this value is fixed)
diprint (this value is fixed)
Notification Notification of print job completion.
Workgroup name Name of the workgroup.
Computer name Name of the computer.
Comment Comment.
Share name|[1] Share name (name of the printer type).
IEEE 802.11b " SSID being used.
SSID Channels available for use.
Channel range Channel being used.
Channel IEEE 802.11b interface transmitting mode.
Communication mode IEEE 802.11b interface speed.
Rate Whether WEP is enabled or disabled.
WEP encryption Validity or invalidity of the authorized mode setting
Auth when using WEP.
Encryption key WEP key.
IP over 1394 ™
Device name
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
SCSI print ™
Bidi. Bidirectional setting (on/ off).
Shell mode Mode of the remote maintenance tool.

*1
*2
*3

*4

The 1394 Interface Unit Type 4510 supports TCP/IP only.

¥7 represents a target number between 1 and 5.

You can display the item names when installing the optional 802.11b Interface Unit
Type A.

You can display the item names when installing the optional 1394 Interface Unit
Type 4510.



Message List

Message List

This is a list of messages written to the machine's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ telnet : Use the syslog command. See p.97 “System log information” .

Message

Description and Solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print
server on the NetWare server or the password
was incorrect.

(In print server mode) Cannot log in to the file
server. Make sure that the print server is regis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists.
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>,
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is
TRAP. Specify the host IPX address for the
TRAP destination.

add_sess_ipx: community <community
name> already defined.

The same community name already exists.
Use another community name.

add_sess_ipx:session_ipx<community name>
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk)

An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name>

Attached to the file server as a nearest server.

Attach to print queue <print queue name>

(In print server mode) Attached to the print
queue name.

Cannot create service connection

(In remote printer mode) Cannot establish a
connection with the file server. The number of
file server users may exceed the maximum
number that the file server can handle.
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Message

Description and Solutions

Cannot find rprinter (<print server
name>/<printer number>)

The printer having the number displayed on
the print server does not exist. Make sure that
the number of the printer is registered in the
print server.

Change IP address from DHCP Server.

The IP address changes when DHCP LEASE is
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

child process exec error! (process name)

Failed to start the network service. Turn the
printer off and then on. If this does not work,
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from
the DHCP server.

connection from <IP address>

Logged on from the host <IP address>.

Could not attach to FileServer<error number>

(In remote printer mode) Cannot attach to the
file server. For some reason, the file server
refuses the connection. Check the file server
configuration.

Could not attach to PServer<print server>

(In remote printer mode) Cannot attach to the
print server. For some reason, the print server
refuses the connection. Check the print server
configuration.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100 Mb-
ps).

Current IP address <current IP address>

The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address>

The current IPX address.

DHCP lease time expired. DHCEP lease time has expired. The printer tries
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure
the DHCP server is running on the network.

dhcped start. A dhcpced (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,
(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with
the print server has been established.

exiting

Ipd service has ended and the system is exiting
the process.
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Message

Description and Solutions

Exit pserver

(In print server mode) Exits the print server
because the necessary print server settings
have not been made.

Frametype =<frame type name>

The <frame type name> is configured to be
used on NetWare.

httpd start.

An httpd has started.

IEEE 802.11b current channel <Channel>

The current channel is displayed.

The value chosen by the user is displayed in ad
hoc mode.

The channel used in the access point is dis-
played in infrastructure mode.

(Example: Current channel is 11.)
IEEE 802.11b current channel 11

IEEE 802.11b MAC Address = <MAC Ad-
dress>

The IEEE 802.11b I/F MAC address is dis-
played.

(Example: Current MAC address is
00:00:74:XX:XX:XX.)

IEEE 802.11b MAC Address =
00:00:74:XX:XX: XX

IEEE 802.11b SSID <ssid> (AP MAC Address
<MAC Address>)

The SSID of the access point used in infrastruc-
ture mode and the MAC address of the access
point are displayed.

(Example: Current MAC address is
XX:xx:xx:xx:xx:xx and SSID value is "test-ssid".)
IEEE 802.11b SSID test-ssid (AP MAC Address
XXEXXEXX XX XX XX)

IEEE 802.11b Tx Rate <Transfer Speed>

The IEEE 802.11b transmitting speed (set
speed) is displayed.

(Example: Current Tx Rate is 11Mbps.)
IEEE 802.11b Tx Rate 11Mbps

inetd start.

An inetd has started.

<interface> started with IP: <IP address>

<IP address> has been set for <Interface> and
<Interface> started.

<Interface>: Subnet overlap.

Subnet from Netmask and the IP address you
tried to set for <Interface> overlap the subnet
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied.

The printer could not authenticate the name of
the user attempting to cancel a job.

ipp disable.

Printing with ipp is disabled.

ipp enable.

Printing with ipp is enabled.
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Message

Description and Solutions

IPP job canceled. jobid=%d.

The spooled job has been canceled due to an
error or by user request.

job canceled. jobid=%d.

The spooled job has been canceled due to an
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from
the DHCP server is <lease time> in seconds.
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name>
(<IPX | IP>,<NDS | BINDERY>)

(In print server mode) Logged in to the file
server with NDS or BINDERY mode.

multid start.

Data transmission service for multiprotocols
has started.

nbstart start. (NetBEUT)

The service for NetBEUI protocol stack setting
has started.

NBT Registration Broadcast(<NetBIOS
name>)

Use alocal broadcast to map <NetBIOS name>
with the IP address.

nbtd start.

A nbtd (NetBIOS over TCP/IP Daemon) has
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer
name>

The NetBEUI Computer Name is defined as
<computer name>.

nmsd start. (NetBEUI)

A nmsd (Name Server Daemon) has started.

npriter start. (NetWare)

(In remote printer mode) NetWare service has
started.

nwstart start. (NetWare)

The service for NetWare protocol stack setting
has started.

Open log file <file name>

(In print server mode) The specified log file
has been opened.

papd start. (AppleTalk)

AppleTalk print service has started.

permission denied.

Job cancellation was determined to be unau-
thorized after checking the user name and host
address (except for ROOT authorization).

phy release file open failed.

Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be
serviced by printer 0, <print server name>

(In print server mode) The print queue name
cannot be serviced. Make sure that print queue
volume exists on the specified file server.

Print server <print server name> has no print-
er.

(In print server mode) The printer object is not
assigned to the print server <print server
name>. Using NWAdmin, assign the printer
object, and then restart the printer device.

Print session full

Cannot accept the print session.
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Message

Description and Solutions

Printer <printer name> has no queue

(In print server mode) The print queue is not
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare)

(In print server mode) NetWare service has
started.

Required computer name (<Computer
name>) is duplicated name

The same computer name is detected on the
network. The start job determines the compu-
ter name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

Required file server (<file server name>) not
found

Cannot find the required file server.

restarted.

LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name>

A <NDS context name> has been set.

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUTI)

An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready.

Communication over TCP/IP with SNMP is
available.

Snmp over IP over 1394 is ready.

Communication over IP over 1394 with SNMP
is available.

Snmp over ipx is ready.

Communication over IPX with SNMP is avail-
able.

snmpd start.

SNMP service has started.

started.

Direct print service has started.

The print server received error <error
number> during attempt to log in to the net-
work.Access to the network was denied. Verify
that the print server name and password are
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without
specifying a password.

win2kspd protocol-DOWN (APPEXIT).

NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY).

NVRAM setting ioctl (SPIO CAPPENTRY) of
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.
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Message

Description and Solutions

win2kspd started.

SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response

There has been no response to the update re-
quest from the server. Confirm that the WINS
server address is correct and the WINS server
is working properly.

WINS name registration:Server No Response

There has been no response to the registration
request from the server. Confirm that the
WINS server address is correct and the WINS
server is working properly.

WINS server address0.0.0.0

The WINS server address has not been speci-
fied. Specify the WINS server address to
match the printer name with WINS.

WINS Server=< WINS server address > NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopelD

The scope ID is wrong.

Specify the correct scope ID.

write error occurred. (diskfull)

The hard disk became full while the spool file
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal)

A fatal error occurred while the spool file was
being written.

Turn the printer off and then on. If this does
not work, contact your service or sales repre-
sentative.




Precautions

Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

& Note

O The MAC address of the printer doing the filtering is printed on the printer
configuration page. For more information about printing a configuration
page, see the Setup Guide.

O For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

ﬂ Following the setup method in this manual, configure the file server.
g Set the frame type for a NetWare environment.

A Reference
For more information about selecting a frame type, see the Setup Guide.

Configuring the printer without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

A Reference
For more information about selecting a protocol, see the Setup Guide.

119



120

Appendix

PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tions Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.

e With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Form feed] check box on the [NetWare Settings]
tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]
tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Enable banner] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.

When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print.



Precautions

Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

? Limitation

O DHCP cannot be used with IEEE 1394 (IP over 1394). Set a fixed IP address
with the control panel, telnet or a Web browser.
* See the Setup Guide.
* See p.93 “TCP/IP address”.

* See p.78 “Configuring the Network Interface Board Settings”.

& Note

O Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server. See p.105 “WINS”.

O Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000 Server and NetWare 5.

O If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so that the same IP address is assigned every time.

O DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

& Note
O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the configuration page. For more
information about the configuration page, see the Printer Reference.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.
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Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartNetMonitor for Admin even under a DHCP environment.

This section describes how to configure the WINS server.

& Note

O The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or
later, and Windows 2000 Servers WINS Manager.

O For more information about the WINS Server settings, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

ﬂ Start the Web browser.

gPoint your browser at the URL or IP address of the printer (e.g. ht-
tp /XXX XXX XXX XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

B Click Network Config.
The dialog box for entering the password and user name is displayed.

ﬂ Enter your user name and password, and then click OK.

To use the factory default account, enter no user name and type "password"
for the password.

B Click TCP/IP.

E Set WINS to active and enter the IP address of the WINS server in Primary
WINS Server and Secondary WINS Server.

ﬂ Click Refresh.
B Exit the Web browser.



Precautions

Using telnet

ﬂ Connect to the remote printer using telnet.

g Use the "set" command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following com-
mands.
msh> wins primary Ipaddress msh> wins secondary Ipaddress

& Note
O To confirm the current configuration, use the "show" command.

ﬂ Log out from telnet.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client

When using IPP with SmartNetMonitor for Client, note the following;:

¢ The network printer can only receive one print job from SmartNetMonitor for
Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

¢ If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

 If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

* Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

e If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were sent.

e AnIP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.
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Specifications

Interface

100BASE-TX, 10BASE-T, IEEE 1394 (IP over 1394) !, IEEE 802.11b

Frame type

Ethernetll, IEEE 802.2, IEEE 802.3, SNAP

Protocol

TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

IPX/SPX
NetWare 3.12,3.2,4.1,4.11,4.2,5, 5.1 IntranetWare

NetBEUI ™2
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

PP

Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

AppleTalk
Mac OS 8.6 or later (Mac OS X Classic environment is support-
ed.)

SNMP

MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

"I The 1394 Interface Unit 4510 supports TCP/IP and IPP.
"2 To use NetBEUI, use the SmartNetMonitor for Client port.
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L
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